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Introduction 

This User Guide describes the procedures involved in establishing and maintaining proposals in 
the Trns•port Proposal and Estimates System (PES) for contracted work.   

This User Guide complements the Reference Manual for Production Projects, and is reduced in 
scope to be a quick reference of steps in creating proposals for construction contracts.   

Appendix A shows the structure of Access Control Group. 

 

Creating a Proposal 

To begin the process you do not have to initially define all proposal details, just the Proposal 
Header information.  Tell Trns•port which projects are to be assigned to it, and Trns•port will 
create the proposal details.  After you create the proposal, assign it to a bid letting and produce 
the appropriate proposal and letting documents.   

 

Lump Sum Contracts 

For projects that are to be let as Lump Sum contracts, duplicate projects and proposals will be 
created to track project and proposal detail.  These tracking projects will be set up one for one for 
the proposal and all projects attached to it.  Tracking Projects will be identified by an eleven 
character ID.  The first nine will be the first nine characters of the Financial Project Number 
plus the two characters LS.  These tracking projects will be fully defined with pay items, 
quantities, prices and all other details of a regularly let project. 

The Tracking Proposal IDs will be seven characters in length.  The first five will be the regular 
Contact ID plus the characters LS.  A representative contract number would be T3052LS or 
E2G53LS.  After the regular projects and proposals are created and synchronized with the 
Financial Management System (FM), the tracking projects and their proposal header may be 
created with the copy special feature.   

No other duplicate projects or proposals are to be added to the production environment of 
Trns•port, as they will produce quantity errors in some of the reports 

 

Working with Proposals 

To define a Proposal Header, open the 
Proposals List window, 

• Click the Proposal icon. 

 

Add, change, or delete proposal records 
from this list window. 
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The Proposal Header 

To create a new proposal,   

• Rclick Tabbed Folder Add. 

 

 

 

 

 

 

Trns•port displays the first page of the 
General tab. 

 

 

The General Tab 
 

General Tab page 1 

Begin by entering the lead Project 
Number in the Cntl PCN field.  This will 
save the necessity of re-entering other 
information.   

• Click Cntl PCN.   

• Click the appropriate Financial 
Project Number, from the list box. 

• From the Menu Bar, Click Edit > 
Import Controlling PCN Data. 

If there are several projects to be strung to 
the Proposal Header, import this data for 
the lead project and alter fields in the Proposal Header as 
necessary to reflect the combined work. 

The warning screen tells which fields will be filled with 
imported data.   

• Click YES. 

• Enter as much information as possible for the 
remainder of page 1.  Be sure to enter the 
following required fields. 
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Contract ID    Enter the planned Contract Number.    

District Let Contracts:  Enter the planned District Contract number in the 
general form E#???, where # is District Number and ??? is a sequence number.  
Do not enter dashes or spaces.  If a contract is to be renewable, add the suffix –
R0 to the contract ID 

Central Office Let Contracts:  Enter the planned "T" number in the general 
form T#???, where # is District Number and ??? is a sequence number.  Do not 
enter dashes or spaces. 

Renewable   Assign the flag Y if suffix –R0 is assigned to the Contract Id, otherwise 
assign N. 

Description   Prev Let As ContID Federal/State Project Number  

Contl PCN  Spec Year    Proposal Type 

Contract Type * Bid Method   Primary District 

Managing District. Contract Work Type  Control Group 

Counties   Proposal Class**  Qual Classes***

*Contract Type.  The code table for this field has been restructured as follows. 

Construction Contracts 
CC Construction Contract 
CDB Construction Design Build Contract 
CEC Construction Emergency Contract 
CFR Construction Fast Response Contract 
CHW Construction Hold Witness Contract 
CLS Construction Lump Sum Contract 
CPB Construction Push Button Contract 

 
Traffic Operations Contracts 

TO Traffic Operations Contract  
TOPB Traffic Operations Push Button Contract  

 
Maintenance Contracts 

MAM Maintenance Asset Management 
MC Maintenance Contract 
MCS Maintenance Contractual Svcs Contract 
MEC Maintenance Emergency Contract 
MG Maintenance Grant 
MMOA Maintenance Memorandum of Agreement 
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MPO Maintenance Purchase Order 
**Proposal Class and ***Qual Classes. 

Run the Work Class Percentage Report to find the values 
for these two fields.  Use the highest percentage 
classification, (other than MOT or Other) for the Proposal 
Class.  Use the three highest (other than MOT or Other) 
for the three Qual Class fields.  This step will need to be 
performed when the estimate for the proposal is 
essentially complete. 

When page 1 is complete,  

• Click the page 2 radio button 
located in the upper left corner of 
the General tab. 

 

General Tab page 2 

 

• Continue entering information.  
Most of these fields have default 
values.   

Bid Bond (0) 

Cost of Proposal Package 

Section Assignment Cost of Plans 

Cost of Specs   Cost of Proposal Acquis. Time 

Special Start Date  Proposal Notes    

 

The Description Tab 
The description for the proposal.  It can 
appear on proposal-related reports, such as 
the notice to bidders.  This field should be 
a general description of the work, where it 
is located, and any unusual aspects that 
should be made known.   

In the Proposal tabbed folder window,  

• Click the Description tab.   

Begin entering information on the top row 
and at the extreme left of the window.  
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Enter a description of up to approximately 32,000 characters or 400 lines.  Do not press <ENTER> 
at the end of each line; Trns•port automatically wraps text to a new line.  Press <ENTER> only to 
start a new paragraph.  Use the windows Copy (or CTRL+C) and Paste (or CTRL+V) commands 
from the Edit menu to copy and paste text from other programs such as word processing. 

 

The Sites Tab 
The Site Details window will appear in the 
lower portion of the screen.  The first Site 
number is assigned a default value of "00".  
Enter overall information regarding the 
proposal.  If additional completion dates or 
mandatory start dates are required for 
portions of the proposal, add additional 
rows by clicking ADD MORE.  Number 
these other Sites from 01 onward. 

• For each Site record fill each field 
as appropriate. 

Site Number Type of Days 
Liquidated Damages per Day 
Number of Days 
Specified Start Date 
Specified Completion Date 
Description  

Enter at least one proposal site record.  
The liquidated damages rate has been set 
to "1".  Do not change this value.  Liquidated Damages information will be communicated to 
bidders as a part of the specification package.  Assessed Liquidated Damages will be handled in 
SiteManager. 

When the Site Information is complete, 

• Click OK for the information to be recorded in the data row. 

 

Alternative Contracts 
As noted above, the Site Tab information transfers to SiteManager and may be used for a variety 
of ends including Contract Time, Daily Rates, Incentives and Disincentives, and administrative 
information.   

The Site Tab contains a field named Road User Cost Per Day.  This field is to remain blank 
unless the proposal will be processed under Alternative Contract procedures, in which case it 
will be filled as described below.  When Road User Cost Per Day contains a value, the particular 
Site will be used in the analysis of bids to determine the successful bidder.   
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For Time Bid contracts there are three items of information to be retained from the 
preconstruction work.  These are: 

 The engineers estimated duration for the Contract Time or Lane Rental period. 

 The maximum number of days that bidders may bid for the Contract Time, or for the 
Lane Rental period. 

 The Road User Cost per Day. 

 

A + B Contracts 
At the General tab, 

• Select the appropriate Type in the 
Bid Method field. 

At the Sites tab enter data in the following 
manner. 

• Site Number   Use the default 
value of 00. 

• Liquidated Damages per Day     
There is a default value of $1.00.  
Do not change this value.  
Liquidated Damages will be 
managed in SiteManager. 

• Type of Days     Choose CD in the 
drop down menu from the 
TIMMETH code table. 

• Number of Days      Enter the 
Engineers estimated duration for 
the contract.  

• Road User Cost Per Day     Enter the daily rate determined for the contract. 

• Maximum Days     Enter the maximum number of days that will be indicated in the 
Contract Specifications. 

• Description      Enter "Contract Time" from the SITEDES code table choices. 

• Click OK to save the record to a data row. 

During the analysis phase of the bidding, in conjunction with the bids on Pay Items, the value 
contained in the Road User Cost Per Day times the Number of Days identified for the site will 
be used to determine the successful Bidder. 
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Lane Rental Contracts 
At the General tab, 

• Select the appropriate Type in the 
Bid Method field. 

At the Sites tab create a Site 00 for the 
contract time in the usual manner then 
create additional Sites as described here. 

• Rclick in the white space of the 
Sites Tab 

• Click Add to create a new record. 

 

 

Enter information in the following fields: 

• Site Number   Use one site for 
each instance where lane rental is 
to be managed in SiteManager.  
Begin with 01.  

• Liquidated Damages per Day     
Enter the value identical to the 
Road User Cost Per Day to be 
entered below.  This field will 
transfer to SiteManager as a 
Disincentive amount. 

• Type of Days     Choose CD in the 
drop down menu from the 
TIMMETH code table. 

• Number of Days      Enter the 
Engineers estimated duration for 
the lane rental time. 

• Road User Cost Per Day     Enter 
the daily rate determined for the 
particular Lane Rental activity. 

• Maximum Days     Enter the 
number of days that will be indicated in the Contract Specifications.  (the Maximum 
days). 

• Description      Enter "Lane Rental Days" from the SITEDES code table choices. 
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• Long Description 1      If there is more than one instance of lane rental on the contract, 
describe the particular location here. 

• Click OK to save the record to a data row. 

During the analysis phase of the bidding, in conjunction with the bids on Pay Items, the value 
contained in the Road User Cost Per Day times the Number of Days identified for the Site will 
be used to determine the successful Bidder. 

 

Construction Milestones 
For general Construction Milestones either with or without Incentives and Disincentives, create a 
Site 00 for the contract time in the usual manner.  Then create additional Sites as described here.  
Enter data on the Site Tab in the following 
manner. 

• Site Number   Use one site for 
each instance where a milestone is 
to be managed in SiteManager.  
Begin with Site 20. 

• Liquidated Damages per Day     If 
there is an incentive for the 
Milestone, enter the value.  This 
field will transfer to SiteManager 
as a Disincentive amount.  The 
Incentive value will be entered in 
SiteManager.  Otherwise enter 
zero. 

• Type of Days     Choose CD in the 
drop down menu from the 
TIMMETH code table. 

• Number of Days      Enter the 
number of days associated with the 
particular Milestone.  Specified 
Start Date and Specified Completion Date may be used in conjunction with this duration.   

• Road User Cost Per day     Leave this field blank, as the Site is not to be associated with 
determining the successful bidder.  

• Maximum Days    Leave this field blank. 

• Description      Enter "Construction Milestone" from the SITEDES code table.   

• Long Description 1     Describe the particular milestone here.  This field may contain up 
to 60 characters. 

• Click OK to save the record to a data row. 
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The Projects Tab 
The Projects tab of the proposal.  The 
lower portion of this screen displays a list 
of projects that are not attached to any 
proposal, and so, are available to be 
assigned to the new proposal.  This list 
will only contain projects that match the 
Pay Item Year specified on the General 
tab, and the Unit System of the 
Controlling PCN.   

The first project to be attached to a 
proposal will govern the specification year 
and unit system for the proposal, so that all 
projects displayed in the lower section of 
the window will conform to the Pay Item 
Year and unit system of the lead project.   

 

Warning: In the Tabbed Folder mode, 
controls exist to block a project from being attached to more than one proposal as 
well as requiring all attached projects to be of a common Pay Item Year and unit 
system.  There is the ability to make these erroneous attachments via the drill 
down method.  DO NOT attach projects to proposals in the drill down mode of 
PES, because these protections regarding Pay Item Year, Unit System, with 
respect to previously attached projects are not available. 

To add an additional project or projects to the proposal, scroll through the list in the lower part of 
the window and highlight those to be added.  Highlight multiple projects by holding down the 
CTRL key while selecting the needed projects.  After selecting the projects to add 

• Click the single up arrow in the center of the window.   

Note.  Do not use the double up-arrow.  It will attach every project in the list to 
the proposal header. 

 

The Special Provisions Tab 
The Special Provisions tab features of Trns•port are not being used at this time. 

 

The Sections Tab 
At the Sections Tab. 

• Click Generate Section and Line Numbers.   
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The section numbers are set by Trns•port 
and show in blue, indicating that they 
cannot be changed.  The section 
descriptions are available to be changed if 
desired.  The description will default to the 
description of the lowest category number 
in the section (Structures –0100 or 
Roadway – 0200), and in some cases, will 
need to be changed to reflect the total 
project. 

To add a section to the proposal,  

• Rclick Add.  Trns•port will add a 
blank row to the list of sections.   

• Enter data into the blank fields 
displayed in the detail area of the 
Sections tab page.   

• Enter a proposal section number 
and a description.  

• Click OK to add a proposal section, ADD MORE to add another section, or CANCEL to return 
to the Proposal Sections list without adding a new section.   

• Before leaving the tabbed folder window, save all changes to the database by selecting 
Save from the file menu or choosing SAVE when closing the window.   

 

The Proposal Items Tab 
The estimated prices may be 
changed in the Worksheet.  All 
modified prices will be sent back 
to the original project Item 
price(s), in order to maintain 
consistency of information within 
all parts of the proposal. 

If quantities are to be changed, 
they must be changed in the proper 
project.   

 

The FY Schedule Tab 
The FY Schedule Tab is not in use. 
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The Attachments Tab 
The Attachments Tab is not in use. 

 

Changing Proposals 

To change information about an existing proposal,  

• Rclick the proposal in the Proposals List window 

• Click Tabbed Folder Change from the right mouse button menu.   

Trns•port displays the Proposal tabbed folder window with all current information.   

• Add or change information in any field except Contract ID.   

When changes are complete, 

• Click OK to save them, or CANCEL to return to the Proposal List window without saving. 

 

Deleting Proposals 

You can delete a proposal and its associated references, which include the following information: 

• Related addendum information. 

• List of projects associated with the proposal. 

• Any association between the proposal and a bid letting. 

• Project estimate information for all projects belonging to the proposal. 

Do not delete proposals that still have data in Trns•port LAS (for example, bid tab or 
planholder data).  The Trns•port LAS data for those proposals will not be accessible. 

To delete a proposal: 

• Rclick the proposal(s) in the 
Proposals List window. 

• Click Delete.   

Trns•port displays a Delete window.  If 
you choose Delete, you will delete the 
association of a single proposal with the 
projects associated with the proposal.  You 
will also delete the Proposal Header 
records, sections, addenda, proposal sites, 
and long description.  Click CANCEL to 
return to the Proposals List window 
without deleting. 

• Click OK to continue the delete 
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process.  Trns•port displays a Delete Warning window. 

• Click YES in each of the warning windows to complete the delete process. 

The authority to delete proposals is controlled by security access.  If you are not able to delete a 
proposal, see your District Application Manager. 

 

Preparing to Advertise 

District Let Contracts 
When the proposal is complete and ready to transfer to the district contracts office, open the 
Proposal Header and change the Access Control Group from CD## to CL##.  At the same time 
open the project headers of all associated projects and change their Control Groups to CL##.  
The district contracts office will then initialize the proposal in LAS and prepare the 
advertisement documents. 

 

Central Office Let Contracts 
When the proposal is complete and ready to transfer to the central office, open the Proposal 
Header and change the Access Control Group from CD## to CC##.  At the same time open the 
project headers of all associated projects and change their Control Groups to CC##.  After initial 
processing in the State Estimates Office, the proposal and project Control Groups will be 
changed to CT##.  The Contracts Administration Office will then initialize the proposal in LAS 
and prepare the advertisement documents. 

 

Working with Addenda 

After a contract (proposal) is advertised, all future changes to the proposal must be by 
Addendum.  An Addendum, may include adding Items, changing existing items, or deleting 
items.  The items may be in the same or different categories.   

Remember that it is very important to accurately assign Project Line Numbers and Proposal Line 
Numbers to each Addendum Item to be added.  You will need copies of the proposal level 
Preliminary Detailed Estimate, the Proposal Schedule, and the Generate Section and Line 
Numbers (Inquiry) reports to do this accurately. 

To add an addendum to a proposal 

• Create an addendum header 

• Specify the project, category, and line numbers (Project & Proposal) for each proposal 
addendum Item. 

Re-initialized the Proposal to transfer addendum information from Trns•port PES.   
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Creating the Addendum Header Record 

To create the addendum header: 

• Click the affected proposal in the 
Proposals List window  

 

• Rclick Addendum List. 

 

 

 

 

 

 

• Rclick Add.   

 

 

 

 

 

 

The Addendum Header Detail window.   

 

• Enter information for the following 
fields: 

Proposal Addendum No. 

Date of Addendum 

Description   

 

When the addendum detail is complete,  

• Click OK to save the record, ADD 

MORE if adding another addendum 
header, or CANCEL to return to the 
Addenda list window without 
adding an addendum. 
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Addendum Item Information 

For the first change to a proposal, there will be no Addendum Item information. 

To create the first one: 

• Rclick the addendum header. 

• Click Addendum Items. 

• With the Item list blank, place the 
cursor in the white space and 

 

 

• Rclick Add. 

Select from: 

• New Item 

• Modify Item,  

or 

• Remove Item 

Choose the appropriate action and proceed 
as indicated below. 

 

Adding New items 
The Add Addendum Item Detail window 
will open. 

On this screen, in sequence: 

• Click the Project No., from the list 
box. 

• Click the Category Number from 
the list box. 

• Enter a Project Item Line No. that 
does not already exist on the 
project.  Examine the project 
worksheet, the Preliminary 
Detailed Estimate or Generate a 
Section and Line Numbers 
(inquiry) report and assign 
appropriate line numbers. 
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• Enter an Item Number or select from the list box. 

• Enter the Quantity for the added Item. 

• Assign a Proposal Line Number that does not 
already exist on the proposal, unless it is to 
combine with existing Project Line Numbers.  
Recall that  the Proposal Line Numbers are 
initially assigned in steps of five.  Examine a copy 
of the Proposal Schedule and determine where the 
Item should be displayed, and assign an 
appropriate number.   

• Click OK. 

Or 

• ADD MORE if other items are to be added. 

 

Modify Existing Items. 
If the addendum is to modify one or more 
Items, 

• Click Add > Modify Item. 

Proceed sequentially to: 

• Click the Project Number from the 
list box. 

• Click the Category Number. 

• Click the Project Line Number 
from the list box (the Pay Item and 
Proposal Line Numbers are now 
identified). 

• Enter the corrected quantity. 

• Click OK or ADD MORE if other 
Item quantities are to change. 
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Deleting items 
If an Item is to be deleted,  

• Click Add > Remove Item. 

Then, in sequence select: 

• Project Number from the list box 

• Category Number from the list box 

• Project Item Line Number from 
the list box. 

The deletion is now fully detailed, as all 
other fields on the window are blue. 

Addendum items WILL NOT show in the 
Items Tab in the Proposal Folder.  The 
Addendum items WILL show on the 
Proposal Schedule Report. 

 

Correcting Addendum Item Information 

If the addendum has been completed and there are errors, it may be re-opened.  To do this,  

• Click the proposal involved from the Proposal List window. 

• Rclick Addendum List.   

To change the header information,  

• Rclick Change, and make the necessary corrections. 

If it is necessary to add change or delete Items,  

• Click Addendum Items.   

Trns•port now displays the Addendum 
Items List window.   

• Click the Item of interest. 

• Rclick Change.   
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Several fields are now in blue, and cannot 
be changed.   

• Change other information as 
necessary.   

• Click OK to save the changes. 

Or 

• Click CANCEL to return to the 
Addendum Items List window 
without saving. 

 

 

 

 

 

Deleting an Addendum 

If an addendum has been entered in error, 
it may be deleted, 

• Rclick the addendum in the 
Addendum List window. 

• Click Delete. 

Trns•port displays Delete Warning 
windows.   

• Click YES in each window to 
complete the delete process. 

 

Maintaining Addendum Item Information 

Trns•port treats each addendum Item record as a transaction to apply to the original project.  
Because Trns•port includes addendum items in Trns•port LAS reports, you must specify the 
project, category, Item number, and Item alternate code (if any) for each proposal addendum 
Item.  Also specify the proposal section number and proposal line Item number. 

To maintain addendum Item information, select the addendum of interest and select Addendum 
Items from the right mouse button menu.  Trns•port displays the Addendum Items List window. 

 

Trns•port PES Proposal Development Guide (Production) - Release 5.9a                                    Page 20 of 32 



Listing Proposal Addenda 

To produce a printed copy listing proposal addendum information,  

• Click the proposal or proposals to list addenda from the Proposals List window.  (Select 
more than one proposal by holding down the CTRL key while selecting proposals.)   

• Click File > Run Process from the Menu Bar.  This will display the Processes window.   

• Click List Proposal Addendum from the report list. 

• Click OK to run the process.   

• Click SUBMIT to run the process, PARAMETERS to change process submission parameters,  

Or  

• Click CANCEL to return to the Proposals List window without running a process.  See 
Running Processes and printing Reports for more information. 

 

Rejecting Bids 

When the situation arises that bids are to be rejected and a contract is to be re-advertised the 
process will begin in the Contracts Office.  Certain fields in LAS will be re-set to indicate that 
the bids are being rejected and the contract re-advertised. 

 

The Old Proposal Header 

Contracts Office 

• Change the Access Control Groups of the proposal and all associated projects from 
CL## to CD##, or from CT## to CD##, as appropriate, so that the district estimator who 
created the Proposal Header will be able to update the projects and create a new Proposal 
Header for the new advertisement. 

District Estimator 

• From the Proposals List window, Rclick the proposal to be modified. 

• Click Tabbed Folder Change.   

• Click the Projects tab 

• Click the single or double down arrow to remove the project(s) from the proposal.   

• After removing the project(s), close the proposal and save the file.  This process makes 
the project(s) available to be attached to a new Proposal Header. 

• Change the Access Control Groups of the proposal from CD## to CL##, or to CT##, as 
appropriate.  The old proposal header will then be available in the appropriate contracts 
administration office for history purposes. 

• When the Save confirmation message opens, click YES. 
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The Projects 

Make any changes to the projects(s) that may be necessary.  Particularly, if there were any 
addenda to the original proposal, enter all changes into the projects before re-advertising the 
proposal. 

 

The New Proposal Header 

• From the Proposals List window, select Tabbed Folder Add from the right mouse button 
menu.   

• In many cases, using the Copy Special feature for projects, categories, and proposal can 
save steps.  In this case, however, it is important to NOT use the Copy Special feature.  
If the original proposal had addenda attached to it, the number of the last addendum 
issued, would be recreated on page 2 of the new Proposal General tab.   

• When the new Proposal general tab window opens: 

o Go to the Cntl PCN: field, and from the list box select the lead project. 

o From the Menu Bar, choose Edit > Import Controlling PCN data. 

o Enter the new Proposal Identifier (“E” Number). 

o Click the page 2 radio button,  

o Enter the Old Proposal Number into the Prev. Let As ContID field.  

o At the Projects Tab, Select any additional project or projects to be connected to the 
new Proposal Header.  Click the single up arrow.   

o Click the Items tab.  A warning window will open indicating that changes have been 
made to the proposal Click OK. 

o Click the Generate Section and Line Numbers button at the bottom of the window. 

o The reconstructed proposal Item information will appear in the Items tab. 

• Save and close the tabbed folder by clicking on the "X" for the tabbed folder window. 

 

Running Processes and Printing Reports 
Project Level Reports 

One of the most useful reports is the Preliminary Detail Estimate.  It may be run at both project 
and proposal levels.  Its value is that it contains all of the structural detail of the project or 
proposal with line numbers, sections, categories, items, and quantities.  Trns•port also 
summarizes the estimate with subtotals in several formats.   
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To run project level reports, begin at the 
Project List window.   

• Rclick the project(s) for which you 
want to generate reports in the 
Projects List window.   

• Click Run Process. 

 

This will display a list of processes that 
are available at the project level.   

 

 

 

Here is a sample list.  Your security authority may not 
permit you to run all of the processes available in the 
system.   

• Click Generate Preliminary Detail Estimate. 

• Click OK.   

Trns•port displays the Detail Cost Estimate Parameters 
window. 

 

The parameter selection window, which has three 
pages.  Page 1 shows a default selection to 
renumber the Item line numbers.   

• If you do not want to renumber them, turn 
off the "x". 

• Click the Page 2 button. 

 

Enter the level of summarization on Page 2.  This 
option determines whether to run the Detail 
Estimate for a project or proposal.  The 
Department is not using prime projects.   

• Click Project level of summarization,  

• Click the Page 3 button. 
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Page 3 shows the Parameters window, which 
allows selection of particular reports.   

• Click the boxes of the desired.   

• Click SUBMIT to run the process, 
PARAMETERS to change process 
submission parameters, or CANCEL to 
return to the Projects List window without 
running a process. 

 

Proposal Level reports 

To generate proposal schedules,  

• Click the proposal in the Proposals 
List window.   

• Rclick Run Process.   

 

 

 

 

 

 

 

This will show the list of processes that are available at 
the proposal level.  Here is a sample list of processes that 
are available.  Your security authority may not permit 
you to run all of the processes available in the system.   

• Click Generate Proposal Schedule from the 
Processes window. 

• Click OK.   

These are the report options.  Because of the 
security of estimates, estimators will need to 
run this process, including the Engineer’s 
estimate, if desired.   

• Click the options desired. 

• Click SUBMIT 
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Two information windows will open to confirm that the process has been submitted and when it 
has completed running.   

• Acknowledge both when they open. 

 

Process Status 

To see the results of this process,  

• From the Menu Bar, Click File > 
Process Status. 

 

 

 

 

This screen lists all of the processes recently 
run. 

• Click the report just run (check the date 
and time columns), 

• DblClick the blue band. 

 

 

 

These are the reports available from this 
process. 

• DblClick the report output1.txt and 
review the report on screen. 

 

 

Electronic Proposals and Addenda 

All central Office and many District Office let contracts will be produced and distributed on 
electronic media.  When the proposal processing has reached the stage of transferring control of 
the proposal to the Contracts Administration Office, the electronic proposal may be prepared.  
All of the processes of creating electronic proposals and addenda are performed in the Contracts 
Administration offices (Central Office and District Offices).  The Proposal will have been 
attached to a Letting Header and the proposal initialized into LAS. 
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Creating the Proposal 

Begin in the Proposals List window as 
seen here.   

• Click the Proposals(s) to be 
prepared. 

• Rclick Run Process. 

 

 

 

 

 

 

• Click Generate Proposal Schedule. 

 

 

 

 
The Proposal Price Schedule Options window 
will open.  It is the same window used to create 
a paper proposal schedule. 

• Check the box labeled Generate Pass 
File to EBS. 

• In the EBS Pass File Name field leave 
the entry UserId.txt. 

• Click Submit. 

 

Wait until the Status Monitor reports that the process has 
completed.  An electronic proposal flat file is now located 
on a Trns•port server. 

• Click OK to close the window. 
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Download Files 

Download the file(s) from the Trns•port system 
and move them to a new location.   

From the Menu Bar, 

• Click Utilities > Download File > Process 
I/O File. 

 

• DblClick the directory qebsfnamdir. 

 

 

 

In the File Name window, 

• DblClick your userid.txt. 
 

 

 

The Save I/O File window will open for you to 
choose file location and name.  Click the Navigate 
Up        icon until you reach this screen: 

For Central Office processing, 

• Choose the folder labeled 
CO_Expedite_Sys on 'Dotvcofp001' (R:). 

• Click Open. 

For District processing, the file structure is built in 
a similar manner, but the CO is be replaced by your district number. 

 

Caution: These next steps will copy the newest 
version of userid.txt and overwrite 
previous versions.  Be sure that 
previous downloads of userid.txt have 
been processed by the Expedite Gen 
module, and the EBS files placed in 
their proper folders. 

This screen will now open to accept the new file. 

• Click Save. 
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Next, you will receive this warning/confirmation message 

• Click Yes to overwrite the file. 

 

The electronic proposal(s) is now complete and available for the 
Contracts Administration Office in either the Central Office or a District Office to prepare discs 
for delivery to prospective bidders using the Expedite program and its modules.  The Gen 
module of Expedite will convert the userid.txt file into another format useable by bidders. 

 

Electronic Addenda 

Once the job has been advertised and proposals distributed to prospective bidders, all changes to 
the proposal will be made by addendum.  

When the addundum has been processed, run the Generate Propsal Schedule again.   

• Check Proposal Cover Sheet to see a 
paper version. 

• Check Proposal Schedule of Items to 
see a paper listing. 

• Check the box labeled Generate Pass 
File to EBS. 

• Click Submit. 

 

The remainder of the steps are the same as the creation of the original file above.  After the Gen 
module in Expedite transforms the file for bidder use, an additional file for each addendum will 
be included. 

 

Web Reports 

In addition to standard reports within PES 
several reports have been created that are 
accessible from the FDOT Intranet.  At the 
URL: 

http://www3.dot.state.fl.us/trnsport2 

you will see this Log In screen.   

 

• Enter your user ID and Password 
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You will see a list of Designer and Pre 
Letting Reports.  Depending on your 
access security, you may have a different 
list.   

 

 

 

 

 

 
Proposal Summary of Pay Items 

To run the Proposal Summary of Pay 
Items  

• Click Proposal Summary of Pay 
Items 

• Enter the Proposal ID in the Input 
Data field. 

• Click Submit. 

• Click Refresh after the report has 
time to run. 

• Click View to see the report. 

 

The report is seen at right. 

 

Other report in this series are generated in 
a similar manner. 
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Appendix A Control Group 

The assignment of Access Control Groups is one of the principal tools available to the 
Department to control access to project data.  Through the plan outlined here, a hierarchy can be 
established where data may be compartmentalized to restrict access to a set of people who need 
visibility of a particular project and to deny visibility to those who don’t. 

The use of Control Groups satisfies two concerns.  The first is to reduce the volume of 
information that will appear on Project List screens, and second to secure information during the 
bidding and award process.  The use of Control Groups allows the visibility of projects to be 
moved from one person to another.  An example would be a project in District 2 that might have 
a Control Group of CD02PMA.  With this Control Group assigned to the project, the District 
Estimator(s), having a personal Access Control Group of CD02*, would always have visibility of 
the project.  Similarly, any person having an Access Control Group that is less restrictive would 
also be able to see the project on his or her project list screen.  For example, a user with an 
Access Control Group of C* would have access to every project in the Production organization 
statewide. 

For the management of projects for Central Office letting, the sequence of Control Groups 
assigned to the Projects and the Proposal Header when it is created, would be as follows: 

• CD02PMA: When under the control of a District Project Manager. 

• CD02: When control of the project shifts from the Project Manager to the District Estimator. 

• CC02: When the District Estimator transfers the proposal to the Central Office for letting.  A 
further refinement here will be decisions in the Central Office Estimates Office about 
compartmentalizing within itself.  For example, a particular estimator may use CC02TW 
(initials) to assign the access to another estimator, or CC02A to have proposals shared by two 
or more Estimators as a group within the overall estimates office. 

• CT02: When the proposal is ready for processing by the Central Contracts Office.  It is 
necessary that the proposal Control Group remain unchanged while the project is in LAS and 
the Contracts Office in order to ensure that the Engineer’s estimate is always under the 
control of only the estimator. 

The following table illustrates how visibility of projects to a community (Maintenance or 
Production) for oversight is granted, and then to a smaller group of project or maintenance staff 
for the control and management of project detail. 

 PES  LAS 

District Contracts Manager      ?L##*  ?L##* 

District Contracts Assistant A      ?L##A* ?L##A* 

District Contracts Assistant B      ?L##B* ?L##B* 

District Estimator       CD##*  CD##* 

Assistant District Estimator      CD##A* CD##A* 
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 PES  LAS 

District Production Director      CD##PM* None 

District Production Project Manager A    CD##PMA* None 

District Production Project Manager B    CD##PMB* None 

District Project designed by Consultant Firm    CD##T### None 

 

District Maintenance Engineer     MD##* None 

Assistant District Maintenance Engineer A    MD##A* None 

District Maintenance Contract Estimator    MD##* MD##* 

Assistant District Maintenance Contract Estimator   MD##A* MD##A* 

 

District Work Program Manager     ?D##*  None 

Central Maintenance Manager     M*  None 

 

Control Group Structure: 

Character position 1:  M = Maintenance Project 

C = Construction Project 

Other characters may be assigned if desired to segment project 
development to other specialty areas. 

 

Character position 2:  D = District Office processing 

C = Central Office processing 

T = Central Contracts Office 

L = District Contracts Office 

 

Character positions 3 & 4: District Number 

Character position 5: The letters T, U, V, W, X, Y, and Z are reserved for Central Office 
and statewide use.  When a consultant firm is the designer of a 
project, the last four characters of the control group will identify 
the consultant firm.  The letters T, U, V, W, X, and Y identify 
consultant firms. 

Character positions 6/7/8: Organizational or subordinate breakout where desired.  For 
consultant firms, these three characters, in conjunction with a letter 
in character position 5, identify the firm. 

A project created and managed in the Central Office could be assigned an office code. 
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The Control Group feature is a very important tool, but it has limitations: 

• It is not a code table and, therefore, will require a thorough understanding of the structure by 
Application Managers and Security Coordinators. 

• Control Group is not available to Letting Headers. 

• When transferring a project or proposal to another user, care must be taken to ensure that all 
letters in the new Control Group are capitalized, and that a valid Control Group has been 
used.  If these precautions are not taken, a project or proposal will be removed from the 
project or proposal list screen of the previous user and will be available to no one.  Under this 
circumstance, a user with high-level authority such as a Security Coordinator or Application 
Manager will have to find the errant project or proposal and assign a valid Control Group to 
it. 

Control Group Life Cycle 
A Control Group assigned to a project/proposal might evolve in the following manner: 

Construction Project 

 Receive Production Project from FM  CD## 

 District reassigns project internally  CD##A (or other subset) 

   Or 

 District reassigns to consultant firm  CD##T365 (or other subset) 

 Pass file to District Estimator   CD## 

 Create Proposal Header   CD## 

 Pass to District Contracts office  CL## 

 Contracts Office processing   CL## (or subset if desired) 

 Pass to Distr Estimator for Bid Analysis CD## 

 Return record to Contracts office  CL## 

 Complete award and execute phases  CL## 

 

   Or for Central Office let contracts 

 Pass file to District Estimator   CD## 

 Create Proposal Header & Price Job  CD## 

 Pass to Central Estimator   CC## 

 Pass to Central Contracts Office  CT## 

 Pass to Central Estimator for Bid Analysis CC## 

 Return record to Contracts office  CT## 

 Complete award and execute phases  CT## 

 

Trns•port PES Proposal Development Guide (Production) - Release 5.9a                                    Page 32 of 32 


	 Introduction
	Creating a Proposal
	Lump Sum Contracts
	Working with Proposals
	 The Proposal Header
	The General Tab
	The Description Tab
	The Sites Tab
	Alternative Contracts
	A + B Contracts
	 Lane Rental Contracts
	Construction Milestones


	The Projects Tab
	The Special Provisions Tab
	The Sections Tab
	The Proposal Items Tab
	The FY Schedule Tab
	The Attachments Tab

	Changing Proposals
	Deleting Proposals
	Preparing to Advertise
	District Let Contracts
	Central Office Let Contracts


	Working with Addenda
	 Creating the Addendum Header Record
	Addendum Item Information
	Adding New items
	Modify Existing Items.
	 Deleting items

	Correcting Addendum Item Information
	Deleting an Addendum
	Maintaining Addendum Item Information
	 Listing Proposal Addenda

	Rejecting Bids
	The Old Proposal Header
	The Projects
	The New Proposal Header

	Running Processes and Printing Reports
	Project Level Reports
	Proposal Level reports
	Process Status

	Electronic Proposals and Addenda
	 Creating the Proposal
	 Download Files
	Electronic Addenda

	Web Reports
	Proposal Summary of Pay Items


	 Appendix A Control Group


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000500044004600206587686353ef901a8fc7684c976262535370673a548c002000700072006f006f00660065007200208fdb884c9ad88d2891cf62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef653ef5728684c9762537088686a5f548c002000700072006f006f00660065007200204e0a73725f979ad854c18cea7684521753706548679c300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020b370c2a4d06cd0d10020d504b9b0d1300020bc0f0020ad50c815ae30c5d0c11c0020ace0d488c9c8b85c0020c778c1c4d560002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken voor kwaliteitsafdrukken op desktopprinters en proofers. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents for quality printing on desktop printers and proofers.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /NoConversion
      /DestinationProfileName ()
      /DestinationProfileSelector /NA
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure true
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles true
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /NA
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /LeaveUntagged
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


